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PAYSLIP TO PAYBACK 

From earning on the job to paying yourself your retirement pension 

Product Requirements & Technical Specification 

Version 1.4  ·  March 2026  ·  Polyglyph Analytica 

 

 

1. Product Overview 

Payslip to Payback is a self-contained UK lifetime financial planning calculator delivered as a Microsoft 

Excel workbook with VBA automation. It guides a user from their current earning life through retirement 

drawdown, surfacing tax efficiency, pension adequacy, and wealth projection in a single integrated tool. 

 

Attribute Value 

Product name Payslip to Payback 

Tagline From earning on the job to paying yourself your retirement pension 

Format Excel .xlsx (user saves as .xlsm to enable VBA) 

VBA module PayslipToPayback_VBA_Module.bas — imported separately 

Current version v1.4  (March 2026) 

Copyright © 2026 Polyglyph Analytica · polyglyphanalytica.com 

Distribution Public domain — no warranty. Not financial advice. 

Target user UK-resident individual or couple, any age, any wealth stage 

 

 

2. Workbook Architecture 

The workbook contains 21 sheets organised into four functional zones, plus one hidden validation helper. 

 

2.1 Sheet Inventory 

# 
Tab 
ID 

Sheet Name Purpose 
Tab 

Colour 

1 S0 Start Here 
Onboarding wizard — 4 sections, dropdowns, 

couple-aware, protected 
Cyan 

2 S1 Dashboard 
KPI tiles, life chapter, competing goals, Next Action, 

alerts 
Navy 

3 S17 Charts & Visuals 6 live charts pulling from all sheets Teal 

4 S2 Life Events 50-row financial biography, 32 event categories Steel 

5 — _val_temp Hidden validation helper (do not delete) Hidden 
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# 
Tab 
ID 

Sheet Name Purpose 
Tab 

Colour 

6 S3 Wrappers 
All tax wrappers, carry forward, AA taper + earnings 

cap 
Steel 

7 S4 Allocation Risk profile targets, drift analysis, rebalancing alerts Steel 

8 S5 State Pension NI record, gap fill ROI, deferral, career break impact Steel 

9 S6 Income Streams 
13 income source types, drawdown sequencing 

priority 
Steel 

10 S7 Monthly Tracker 
Portfolio log + one-off income/expense columns J–

M 
Steel 

11 S8 Projection 65-year year-by-year modelling engine Purple 

12 S9 Monte Carlo 1,000 simulation model Purple 

13 S10 Scenarios Base / Optimistic / Conservative / Stress Test Purple 

14 S11 Care Costs Later-life liability, PV reserve calculator Purple 

15 S12 Market Data 
Live data refresh, manual inputs, FX registry, 

Gemini AI 
Slate 

16 S13 Assumptions 
82 named ranges, 2025/26 HMRC values, user 

override column 
Slate 

17 S14 Disclaimer 6 regulatory sections, copyright, version log Slate 

18 S15 
Children & 

Education 
Cost benchmarks, govt support, opportunity cost Green 

19 S16 Home & Property 
Deposit planner, LISA tracker, equity-as-retirement-

asset 
Green 

20 S18 
Insurance & 

Protection 
Cover requirements, register, gap analysis Green 

21 S20 Asset Register 
50-asset register, CGT calculator, breakdown by 

type/wrapper 
Navy 

 

 

3. Market Data Sheet (S12) 

The Market Data sheet is the live data hub of the workbook. It is divided into four functional sections. Sheet 

protection is active; only designated yellow input cells are unlocked. 

 

3.1 Row Map 

Rows Section Content 

1–2 Banner Sheet title and subtitle 

3–4 Refresh button Form Control button → fires RefreshAllData macro 

5  Button note (amber) 

6  Spacer 

7–13 Gemini key setup Step-by-step instructions + yellow input cell C13 for API key 
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Rows Section Content 

14  Green info bar (free tier confirmation) 

15  Spacer 

16 UK Macro Data Section header 

17  Column headers: Indicator / Current Value / As of Date / API Source / Signal 

18  BoE Base Rate (%) — API auto, grey, VBA writes 

19  UK CPI annual (%) — YELLOW INPUT CELL, user enters manually 

20  10yr Gilt Yield (%) — API auto, grey, VBA writes 

21  FTSE All-World 1yr (%) — YELLOW INPUT CELL, user enters manually 

22  ONS Earnings Growth (%) — YELLOW INPUT CELL, user enters manually 

23  ONS House Price Index — YELLOW INPUT CELL, user enters manually 

24  Spacer 

25 AI Tax Refresh Section header 

26–28  Last query timestamp / Active status / Model in use 

29  Spacer 

30 Currency Registry Section header 

31  Column headers: ISO Code / Description / GBP Rate / As of Date / Source 

32–39  
8 currency slots — ISO code and description are yellow input cells; rate and 

date written by VBA 

40  Spacer 

41 FX Log Section header 

42  Log column headers 

 

3.2 Data Sources 

Indicator Source Method Key required? 

BoE Base Rate (%) 
Bank of England IADB 

(IUDBEDR) 

VBA HTTP GET → CSV 

parse 
No 

10yr Gilt Yield (%) 
Bank of England IADB 

(IUDMNZC) 

VBA HTTP GET → CSV 

parse 
No 

FX spot rates 
ECB Statistical Data 

Warehouse 

VBA HTTP GET → 

JSON parse 
No 

UK CPI annual (%) Manual entry 
User types into yellow 

cell 
N/A 

FTSE All-World 1yr (%) Manual entry 
User types into yellow 

cell 
N/A 

ONS Earnings Growth 

(%) 
Manual entry 

User types into yellow 

cell 
N/A 
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Indicator Source Method Key required? 

ONS House Price Index Manual entry 
User types into yellow 

cell 
N/A 

AI Tax Parameters 
Google Gemini 1.5 

Flash 
VBA HTTP POST Yes — free (AIza...) 

 

3.3 Manual Input Cell Specification 

The four indicators that cannot be fetched automatically (CPI, FTSE, Earnings Growth, HPI) are presented 

as unlocked yellow input cells following the workbook's standard input cell convention. 

 

Cell Indicator Format Notes 

C19 UK CPI annual (%) 0.00% 
Enter as decimal, e.g. 0.0327 for 3.27%. Source: ONS CPI H 

or CPIH. 

C21 
FTSE All-World 1yr 

(%) 
0.00% 

Enter 12-month total return as decimal. Source: 

vanguard.co.uk or similar. 

C22 
ONS Earnings 

Growth (%) 
0.00% 

Annual whole economy earnings growth. Source: ONS 

EARN01 release. 

C23 
ONS House Price 

Index 
0.00% 

UK HPI annual change. Source: ONS UK HPI or 

Nationwide/Halifax. 

D19 As of Date (CPI) DD/MM/YYYY Date of the data used — enter when updating value in C19. 

D21 As of Date (FTSE) DD/MM/YYYY Date of the data used — enter when updating value in C21. 

D22 
As of Date 

(Earnings) 
DD/MM/YYYY Date of the data used — enter when updating value in C22. 

D23 As of Date (HPI) DD/MM/YYYY Date of the data used — enter when updating value in C23. 

 

 

4. VBA Module Specification 

The VBA module is distributed as a separate .bas file and must be imported after the workbook is saved as 

.xlsm. 

 

4.1 Function Reference 

Function / Sub Trigger Purpose 

RefreshAllData() Form Control button 
Orchestrates full refresh: BoE rates, ECB FX, signals, 

summary dialog 

FetchBoECSV(code, 

date) 

Called by 

RefreshAllData 

GETs BoE IADB CSV, parses last data row, returns 

rate as Double 

ConvertBoEDate(str) 
Called by 

FetchBoECSV 
Converts "DD Mon YYYY" → "DD/MM/YYYY" 

FetchECBFXRates(ws) 
Called by 

RefreshAllData 

Loops currency registry; GETs ECB SDW JSON per 

currency; parses observation array 

GenerateSignals() 
Called by 

RefreshAllData 

Writes BUY/HOLD/SELL signals to col F based on 

BoE rate and gilt yield 
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Function / Sub Trigger Purpose 

QueryTaxParameters() Macros menu (manual) 
Validates Gemini key, calls Gemini 1.5 Flash, shows 

preview, logs to AuditLog 

CallGeminiAPI(key, 

prompt) 

Called by 

QueryTaxParameters 

POSTs to Gemini generateContent endpoint; parses 

candidates[0].content.parts[0].text 

BuildTaxQueryPrompt() 
Called by 

QueryTaxParameters 

Returns structured JSON-only prompt for UK tax 

parameter extraction 

WriteAuditLog(action…) 
Called by 

QueryTaxParameters 

Appends timestamp, prompt, response to auto-created 

AuditLog sheet 

TogglePartnerFields() 
Worksheet_Change on 

C12 

Locks/unlocks and clears partner input cells on Start 

Here 

ProtectSheet(ws) Shared helper 
Applies standard sheet protection (no password, 

sort/filter locked) 

 

4.2 API Endpoints 

Service URL Pattern Auth Cost 

BoE 

Base 

Rate 

bankofengland.co.uk/boeapps/database/_iadb-fromshowcolumns.asp 

?csv.x=yes&SeriesCodes=IUDBEDR&CSVF=TN&UsingCodes=Y&Datefrom=… 
None Free 

BoE 

Gilt 

Yield 

Same URL with SeriesCodes=IUDMNZC None Free 

ECB 

FX (per 

CCY) 

data-api.ecb.europa.eu/service/data/EXR/D.{CCY}.GBP.SP00.A 

?format=jsondata&lastNObservations=1 
None Free 

Gemini 

AI 

generativelanguage.googleapis.com/v1beta/models/ gemini-1.5-

flash:generateContent?key={KEY} 

API key 

(AIza…) 

Free 

tier: 

1,500 

req/day 

 

4.3 Sheet Constants (VBA row/col references) 

All cell references use Excel 1-based row/column numbering. These constants must stay in sync with the 

build script if the sheet layout is modified. 

 

Constant Value Cell Purpose 

MD_KEY_ROW 13 
Row 

13 
Gemini API key row 

MD_KEY_COL 3 Col C Gemini API key column 

MD_BOE_ROW 18 
Row 

18 
BoE base rate value cell 

MD_GILT_ROW 20 
Row 

20 
Gilt yield value cell 

MD_DATE_COL 4 Col D As-of date column 

MD_SIG_COL 6 Col F Signal output column 
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Constant Value Cell Purpose 

MD_CCY_START 32 
Row 

32 
First currency registry row 

MD_AI_LAST 26 
Row 

26 
Last AI query timestamp cell 

MD_AI_ACTIVE 27 
Row 

27 
AI parameters active flag 

 

 

5. Setup Instructions 

5.1 One-Time Setup (approx. 5 minutes) 

1. Open Payslip_to_Payback_v1.4.xlsx in Microsoft Excel. 

2. File → Save As → Excel Macro-Enabled Workbook (.xlsm). Keep the same file name. 

3. Alt+F11 to open the VBA editor. 

4. File → Import File → select PayslipToPayback_VBA_Module.bas. 

5. Close the VBA editor. 

6. Right-click the "Refresh All Market Data" button on the Market Data sheet → Assign Macro → select 
RefreshAllData → OK. 

7. In the VBA editor, open the Start Here sheet module (expand Microsoft Excel Objects in the left 
panel) and paste the Worksheet_Change event code (see §5.2). 

8. Save the .xlsm file. 

 

5.2 Start Here Sheet Event Code 

Paste this into the Start Here sheet module (not the standard module) via Alt+F11: 

 

Private Sub Worksheet_Change(ByVal Target As Range) 

    If Not Intersect(Target, Me.Range("C12")) Is Nothing Then 

        Call TogglePartnerFields 

    End If 

End Sub 

 

5.3 Getting a Free Gemini API Key 

The Gemini key is required only for the AI Tax Refresh feature. The key is entirely free; usage at normal 

scale will not be charged and no credit card is required. 

 

9. Go to: https://aistudio.google.com/app/apikey 

10. Sign in with any Google / Gmail account. 

11. Click "Create API key" → "Create API key in new project". 

12. Copy the key (it starts with AIza...). 

13. Paste it into Market Data cell C13 (the yellow input cell). 

 

Free tier limits:  1,500 requests/day  ·  15 req/min  ·  No credit card required  ·  No charge at this usage level. 
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6. Input Conventions 

Convention Meaning 

Yellow background Unlocked input cell — user enters data here 

Grey background, italic text Locked cell — populated by VBA or formula 

Blue text Hardcoded input value 

Black text Formula-derived value 

Green text Cross-sheet formula reference 

Light green background On-track status indicator 

Light red background Alert or warning status indicator 

 

 

7. Key Assumptions (S13 Named Ranges) 

All 82 named ranges are defined on the Assumptions sheet. Values reflect 2025/26 HMRC rates. Users can 

override in the override column without editing formulas. 

 

7.1 Tax & NI (England 2025/26) 

Named Range Value Description 

PA 12,570 Personal Allowance (£) 

BRL 50,270 Basic Rate Limit (£) 

HRL 125,140 Higher Rate Limit / PA taper threshold (£) 

BR_PCT 20% Basic Rate 

HR_PCT 40% Higher Rate 

AR_PCT 45% Additional Rate 

NI_PT 12,570 NI Primary Threshold (£) 

NI_UEL 50,270 NI Upper Earnings Limit (£) 

NI_MAIN 8% NI Main Rate 

NI_UPPER 2% NI Upper Rate 

NI_CLASS3 17.45 Class 3 NI weekly rate (£) 

NI_QUAL_YRS 35 Qualifying years for full State Pension 

 

7.2 Pension 

Named Range Value Description 

PENSION_AA 60,000 Annual Allowance (£) 

MPAA 10,000 Money Purchase Annual Allowance (£) 

PENSION_MIN_AGE 57 Minimum pension access age (NPA 57 from 2028) 

TFC_FRAC 25% Tax-free cash fraction 
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Named Range Value Description 

PENSION_IHT_2027 1 Flag: pension in scope of IHT from 2027 

 

7.3 Modelling 

Named Range Value Description 

CPI 2.5% Base inflation assumption 

EQ_RET_ACC 6.5% Equity return (accumulation) 

EQ_RET_DEC 4.5% Equity return (decumulation) 

BOND_RET 3.0% Bond return assumption 

CASH_RET 4.0% Cash return assumption 

HPI 3.0% House Price Inflation 

CARE_ANNUAL 50,400 Annual care cost (£, today's money) 

MC_EQ_SD 15% Monte Carlo equity standard deviation 

MC_BOND_SD 6% Monte Carlo bond standard deviation 

MC_INF_SD 1.5% Monte Carlo inflation standard deviation 

SP_WEEKLY 230.25 State Pension weekly rate (£) 

SP_ANNUAL 11,973 State Pension annual rate (£) 

SPA 66 State Pension Age 

SP_DEFER 5.8% State Pension deferral rate (per year) 

 

 

8. Pension Annual Allowance Logic (Wrappers Sheet) 

The effective Annual Allowance is calculated in three stages on the Wrappers sheet: 

 

Stage Formula / Logic Cell 

1. Tapered AA 
=MAX(10000, MIN(60000, 60000 - MAX(0, AdjustedIncome - 

260000) / 2)) 
C24 

2. Earnings-

based cap 
=MAX(3600, RelevantUKEarnings) C26 

3. Effective AA 
=IF(MPAA_triggered, MIN(10000, MIN(TaperedAA, EarningsCap)), 

MIN(TaperedAA, EarningsCap)) 
C30 

 

 

9. Known Limitations & Exclusions 

Item Status in v1.4 

Defined Benefit (DB) pension modelling Not included — DC/SIPP only 

Scottish income tax rates Not included — England/Wales/NI only 
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Item Status in v1.4 

Inheritance planning in base case Excluded — Optimistic scenario only 

Automatic ONS CPI / FTSE data pull Not automated — manual yellow input cells provided 

Power Query setup for ONS feeds Not bundled — user configures via Data > Get Data 

Multi-property portfolio Single primary residence + one investment property 

Trust structures Not included 

Non-UK domicile / remittance basis Not included 

Pension IHT (post-2027) Flag only — detailed modelling deferred to v2 

 

 

10. Version History 

Version Date Changes 

v1.0 Jan 2026 Initial build — 17 core sheets, VBA foundation 

v1.1 Jan 2026 Phase 14: Pension AA taper + earnings cap; Phase 15: Charts & Visuals tab 

v1.2 
Feb 

2026 

Phase 16–20: Dropdowns, cell protection, couple-aware fields, partner locking, chart 

repositioning 

v1.3 
Feb 

2026 

Amendments H–J: Insurance & Protection, Asset Register, Market Data refresh button 

+ VBA 

v1.4a 
Mar 

2026 
CF consolidation fix: Monthly Tracker 650 → 2 conditional format rules 

v1.4b 
Mar 

2026 
Copyright + disclaimer expansion; Polyglyph Analytica branding 

v1.4c 
Mar 

2026 

Real BoE/ECB API calls replacing placeholders; Form Control button; Gemini AI 

integration 

v1.4d 
Mar 

2026 

Bug fixes: Chr(10003)→ChrW; MD_BOE_ROW/GILT_ROW constants corrected; 

value col corrected 

v1.4e 
Mar 

2026 

ECB JSON parser rewritten to target observation array value (not key); INR added to 

FX registry 

v1.4f 
Mar 

2026 

Gemini key instructions: explicit free/no-charge messaging added to sheet and VBA 

dialog 

v1.4g 
Mar 

2026 

Manual input yellow cells for CPI, FTSE, Earnings, HPI; VBA no longer 

overwrites manual rows; this document 

 

 

11. Legal & Disclaimer 

Important:  This workbook is released into the public domain without warranty. Calculations may contain 

errors. Nothing in this tool constitutes financial advice. Always consult an FCA-regulated financial adviser 

before making investment, pension, or tax decisions. Past modelled returns are not indicative of future results. 

 

© 2026 Polyglyph Analytica · https://polyglyphanalytica.com 
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Google Gemini is a service of Google LLC. Bank of England and ECB data are © their respective owners 

and provided under open data licences. 


